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CAM350 系列软件培训课程大纲 

1. 用户界面(User Interface)和 Gerber 数据的熟悉 

不同编辑器(Editors)的基本功能 (CAM、CAP 和 Part) 
不同 Gerber 文件的格式(RS-274D、274X、Fire 9000 和 Barco DPF) 

2. 开始 

AutoImport 和 Manual Import 
加载 Gerber 和 孔径(Aperture)数据，设置正确的 Gerber 格式并加载层(layers) 
孔径(Aperture) 
孔径表(Aperture Table)，以及怎样输入和删除孔径(apertures)。本身的(Intrinsic)和用户定制孔径(Custom aperture)
之间的不同之出。 

热键(Hot Keys) 
热键(Hot Keys)功能将分配在键盘上的哪些键用于热键，帮助用户快速地查看和移动应用程序中的数据。 

3. 编辑(Editing)功能 

查看(Viewing)选项 

层(Layering)的功能 (Layer Bar, 层的颜色和标识) 
编辑(Editing)命令(Add、Delete、Copy、Move 等) 
"组(Grouping)"功能和过滤(filtering) 
多边灌注(Polypour)功能 (Vector 和 Raster 多边形等) 

4. 绘图(Plotting) 
选择和配置不同的打印机/绘图机驱动程序 

绘图(Plotting)选项(Fit、Center、Separate Sheets、Scale 等) 
5. 实用程序(Utilities) 

CAP Editor 
Draw-to-Flash 
Netlist Extract 
Clear Silkscreen 
Pad Removal 
Teardrop 
Over/Under Size 
Drill (Setup, Create, Sort, Add, Gerber-to-Drill) 
Mill (Setup, Create, Tab, Sort) 
Net Check 
DRC 
DRC Histogram 
Panelization (Autofilm, Panelize, Repanelize, Unpanelize) 
Venting 
Copper Area 
Part Editor 

6. CAM350 快捷键 

7. CAM350 实用经验技巧集 
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用户界面(User Interface) 

 

GERBER FILE 简介 
GERBER 格式的数据特点： 
  -----数据码：ASCLL、EBCDIC、EIA、ISO 码，常用：ASC II 码。 
  -----数据单位：英制、公制、常用：英制 
  -----坐标形式：相对坐标、绝对坐标，常用：绝对坐标。 
  -----数据形式：省前零、定长、省后零，常用：定长 
 
常见数字和字母意义： 

D01：LIGHT ON 
D02：LIGHT OFF 
D03：FLASH 
 
D10～Dn： APETURE CODE 
G54：更换镜头 
M02：结束 

 
几种常见格式及范例： 
Mda9000 格式 
EX： 
G04%PAR.%* 
G04%MODE=A；%* 
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G04%UNIT=I；%* 
G04%ZERO=L；%* 
G04%ADRS=EIGHTH；%* 
G04%SMUL=UP；%* 
G04%NEXT=’ - ‘；%* 
G04%NFLG=MERGE；%* 
G04%MRGE=PAINT；%* 
G04%POEX=799，798；%* 
G04%POIN=797，796；%* 
G04%FORM=2.4；%* 
G04%IMTP=P；%* 
G04%FSZE=20，24；%* 
G04%EOP . %* 
G04%APR，100000.%* 
G04%A10：＋CIR，200.%* 
G04%A11：＋CIR，600.%* 
G04%A13：＋CIR，1000.%* 
G04%A999：＋CIR，3400.%* 
G04%EOA.%* 
G74* 
G54D799* 
X345Y46661D02* 
Y177D01* 
X59490* 
X12215Y16383D02* 
X12295Y16463D01* 
Y14183D02* 
Y14143D01* 
Y14183* 
Y15103* 
* 
M02* 
 
RS-274-D 格式 
EX： 
G54D10＊ 
X1000Y1000D02＊ 
X2000Y2000D01＊ 
X1000Y2000D02＊ 
X2000Y1000D01＊ 
D11＊ 
X3000Y3000D03＊ 

 
 

M02 
 
RS-274-X 格式 
EX： 
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%FSLAX24Y24*%          INCH 
%IPPOS*%%MO IN  *% 
%AMETCH100V* 
22，1，0.075000，0.075000，-0.000700，-0.000700，-45.000000* 
22，1，0.075000，0.075000，0.000000，0.000000，135.000000* 
% 
%ADD10C，0.01500*% 
%ADD11C，0.01000*% 
%ADD12C，0.01400*% 
%ADD13C，0.02500*% 
%ADD14C，0.05000*% 
%ADD15C，0.07500*% 
%ADD17C，0.06600*% 
%ADD24C，0.08000*% 
%ADD25C，0.17500*% 
%ADD26C，0.09000*% 
%ADD27C，0.10000*% 
%ADD28C，0.06000*% 
%LNE115.GTL*% 
%LPD*% -------作线 
G54D24* 
X-35759Y42269D03* 
X-37759D03* 
X-31009D03* 
X-33009D03* 
G54D26* 
X-63259Y30769D03* 
X-63394Y25764D02* 
X-47465D01* 
 
M02* 
 
 
坐标格式： 

＊LEADING ZERO SUPPRESS：坐标整数字前面的 0 省略，小数字数不够以 0 补齐。 
＊TRAILING ZERO SUPPRESS：坐标小数字后面的 0 省略，整数字数不够以 0 补齐。 
＊NONE ZERO SUPPRESS：整数和小数字数不够均以 0 补齐。 
＊FORMAT（小数点之隐藏） ：共有十种格式。 
 

单位制： 
       METRIC（mm） 
＊UNIT 
       ENGLISH（inch or mil） 

 
单位换算： 

     1 inch ＝ 1000 mil ＝ 2.54 cm ＝ 25.4 mm 
          1 mm ＝ 0.03937 inch ＝ 39.37 mil 
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GERBER FILE 极性介绍： 
正片（POSITIVE） ：GERBER 描述是线路层，并且描述之图形主要是有铜部分。或 GERBER 描述是防焊层，并且

描述之图形主要是防焊部分(即盖油墨部分)。 
负片（NEGTIVE） ：GERBER 描述是线路层，并且描述之图形主要是无铜部分。或 GERBER 描述是防焊层，并且

描述之图形主要是无防焊部分(即不盖油墨部分)。 
复合片（COMPOSTIVE） ：GERBER 所描述的层次由不同极性层合成。通常是挖层和正极性层叠加。 
挖层极性为 c，主要起线路防护或追加制程资料等作用。 

四．镜头档(APETURE FILE)介绍 
＊镜头档主要描述相应 Gerber File 所用镜头之形状和大小 
＊APETURE FILE＋GERBER FILE＝完整的 PCB LAYOUT 图形 
 
常用字段： 
D_CODE：D 码，即镜头编号 
SHAPE：镜头形状 
SIZE ：镜头大小 
 
基本镜头： 
 
       ：ROUND，CIRCLE，C，CIR…….. 
 
       ：SQUARE，S，SQR 
 
       ：OBLONG，OB， 
 
       ：RECTANGLE，RECT，…….. 
 
       ：ANNULUS 
 
       ：TARGET 
 
       ：THERMAL 花孔 
 
 
使用者自定义镜头 CUSTOMER APETURE 
 
                 ＝               ＋ 
 
 
 
 
常见镜头档格式，见 C：\CONVERT 目录下的。DOC 文件。 

五．钻孔档(DRILL FILE)介绍 
常见钻孔及含义： 
      ＊PTH – 镀通孔：孔壁镀覆金属而用来连接中间层或外层的导电图形的孔。 

＊ NPTH – 非镀通孔：孔壁不镀覆金属而用于机械安装或机械固定组件的孔。 



资料整理---收藏天地 2001 站长：killmai   网址：www.edaworld.net  E-MAIL:killmai@163.net  

＊VIA – 导通孔：用于印制板不同层中导电图形之间电气连接(如埋孔、盲孔等)，但不能插装组件引腿或其它

增强材料的镀通孔。 
＊ 盲孔：仅延伸到印制板的一个表面的导通孔。 

      ＊埋孔：未延伸到印制板表面的导通孔。 
 
坐标格式： 

＊LEADING ZERO SUPPRESS：坐标整数字前面的 0 省略，小数字数不够以 0 补齐。 
＊TRAILING ZERO SUPPRESS：坐标小数字后面的 0 省略，整数字数不够以 0 补齐。 
＊NONE ZERO SUPPRESS：整数和小数字数不够均以 0 补齐。 
＊FORMAT（小数点之隐藏） ：共有十种格式。 

 
单位制： 

       METRIC（mm） 
＊UNIT 
       ENGLISH（inch or mil） 

 
单位换算： 

     1 inch ＝ 1000 mil ＝ 2.54 cm ＝ 25.4 mm 
          1 mm ＝ 0.03937 inch ＝ 39.37 mil 

 
几种常见格式及范例： 
S&m 格式  
EX： 
X-5.Y-7.5T01 
XY-7.5 
X293.Y-7.5 
X-5.Y246.5 
X293.Y246.5M30 
X5.58Y-36T02M31 
X3.53Y2.81 
X133.85Y-2.08 
XYM50 
X.01Y62.M50 
X.03Y124.07M50 
X.04Y186.09M50 
X149.18Y186.07M50 
X149.21Y124.04M50 
X149.19Y62.01M50 
X149.2Y-.04M50M30 
X10.Y-7.5M30 
X16.01Y3.3T04M31 
X61.67Y3.28 
X76.95Y3.28 
XYM50 
X.01Y62.M50 
X.03Y124.07M50 
X.04Y186.09M50 
X149.18Y186.07M50 
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X149.21Y124.04M50 
X149.19Y62.01M50 
X149.2Y-.04M50M30 
X20.Y-7.5M30 
 
Exel.drl 格式 
EX： 
% 
M48 
T1C0.125 
T2C0.028 
T3C0.035 
T4C0.0394 
T5C0.04 
T6C0.0433 
% 
T1 
X0Y114222 
X0025Y114222 
X06417Y114722 
X12584Y114222 
X12834Y114222 
X12834Y-002 
X12584Y-002 
X06417Y-0025 
X005Y-002 
X0025Y-002 
X0Y-002 
T2 
X0311Y00788 
X03425Y00788 
X02913Y00788 
X01575Y00406 
X07008Y0317 
M30 
 

六、钻孔盘(DRILL RACK)介绍 
＊主要描述钻孔档中用到的钻头大小，有的还说明孔是 PTH 或 NPTH。 
＊钻孔盘一般以 M48 开头，排列在钻孔文件的前面。也有单独以文件说明。 
＊DRILL RACK＋DRILL FILE＝完整的钻孔图形 
 
常用字段： 
Tool ：钻头编号 

Size ：孔径大小 

Pltd ：PTH 或 NPTH 说明 

Feed ：下刀速 

Speed ：转速 
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Qty ：孔数 
 
 
 
 
 
 
 
 
 
 
编辑器(Editors)的基本功能 (CAM、CAP 和 Part) 
CAD/CAM (计算机辅助设计与制造)： 
计算机辅助设计是使用专门的软件工具来设计印刷电路结构；计算机辅助制造把这种设计转换成实际的产品。 
这些系统包括用于数据处理和储存的大规模内存、用于设计创作的输入和把储存的信息转换成图形和报告的输出 
CAM350 正是这样一个 CAM 的处理软件。 
 
CAP Editors：为光栅编辑辑器。作用：建立或修改一个自定义 D 码。后缀为：CLB 
Part Editors：为零件编辑器。作用：建立或修改一个新的零件。 后缀为：PLB 
 
Flying Probe Editors：为飞针编辑口器。 
简单介绍： 
飞针测试机：指的是测试机的一种，用来测试成品 PCB 的，测试 PCB 线路的开路、短路。 
针测试机的测试短路的工作原理：用一组或几组（一组有两个测试针）的测试针接触 PCB 原本是不相连的两条线路

的任意一个端点·然后通电来测试该线路是否有连接，和我们用万用电表量测两根电线是否短路的原理类似·一块

PCB 有许多条线路，飞针测试机会一组组的去量测开、短路·所以测试一块 PCB 需要的时间很长，但是它不用做针

床，省去很多成本·因为它的测试针是活动的，和万用电表的探棒类似，可以重复使用·这就是飞针测试机的名称由

来：“飞针“飞针测试机测试时需要一个测试资料，告诉测试机要用测试针来接触 PCB 的哪个位置的点来通电测试· 
现在我们来谈谈 CAM350 的飞针编辑器，它就是来产生这个测试资料的·首先要进行网路抽取，然后在飞针编辑器

里产生测试点（就是测试针要接触的 PCB 上的点），然后再选择对位点（让测试机的测试针和 PCB 的位置对准，不

然的话，测试针接触 PCB 的位置就偏掉了，不能通电测试了，能明白不？），就可以输出这个测试资料了，有好几个

飞针测试机的型号（例如：Probot,ATG,Mania 等等）· 
 
Bed Of  Nails Editors：为针床编辑器，即我们所说的电脑测试架。原理与飞针的一样的，只是所用的机器不一样。 
 
NC Editors：为数控钻带数据，即 CNC 数据。 
 
二、数据的读入 

在 CAM350 中，数据的读入有两种方式（注：数据必须为 Gerber 格式的数据），一种为自动输入（AutoImport ） 
另一种为手工输入（Manual Import）. 
 
自动输入（AutoImport ）： 选择此方式，操作前须为 Gerber 的所有有关文件存放好在一个目录中。在读入时，程

式会自动载入所有数据和 D 码文件，非常方便。（我主要以这种方式为主） 
 
手工输入（Manual Import）： 此方式，须手工选择要输入的文件数据，不太方便。 
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加载 GERBER 文件 

自 动 输 入： 
1. 在 CAM350 中，读入 GERBER 文件的方法有两种： 

分别为：自动载入和手工载入 
说明其操作（特点：方便。因在 CAM350 V6 中普遍的 D 码其都能自动识别载入）。 
首先：自动读入一个 GERBER 文件，操作：File->Import->AutoImport，如图[1] 
如果使用 CAM350 的 AutoImport 功能输入 RS-274X 格式的 gerber file，操作如下： 
选择 CAM Editor 中的 AutoImport 选项。 

 
 

  
2. 选择文件所在目录（注：载入时，最好为其相关文件建立一个独立的目录。这样的作用是方便文件的读入） 

首先选择单位：English(英制)、Metric（公制）一般为英制。 
然后：按下 Next 进行 GERBER 文件的读入（注：若你的 D 码非 RS-274-X 格式时，请不要选择 Finsh） 

 
需要注意，要输入的所有 gerber file 必须放在同一文件夹中，不能同时有不相关文件在这一文件夹 
中，才能正确读取这一文件夹中的 gerber file。 
 
 

选择 gerber file
放置的文件夹 
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3．按下“Finish“出现如图：将会列出此文件的 D 码类型和光栅格式。 
   确定后，按下 Finsh 完成。 

 
 
设置方法如下：在 AutoImport 对话框中，设置读入的格式即可（注：这里可进行多次设置，以得到正确的格式多数

的 PADS 都是用 2:3 英制或 2:4 英制的。）[如图] 
在 Aperture Format 列表中为可自动识别的 D 码格式 
Gerber Format 为设置当前的底片文件的数据格式类型。 
 

 

       
Digits 

gerber 格式制：一般公制为 3.3, 英制为 2.4, 不行的话, 用猜的, 读对为止 
Coordinates 

绝对坐标 / 相对坐标. 一般是绝对坐标, 不行的话换一个, 直到读对为止 
Zero suppression 

前导零 (0255650 前导零后为: 255650) 
后导零 (0255650 后导零后为: 025565) 

Units 
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    English:英制 
Metric:公制 

 
 
4．按下 Finsh 完成后，若出现此窗口，则表示 Drl01.drl 的 D 码数据并没有正确读入。 
   这时你可直接按“确定”结束，这并不会给 TOP、BOTTOM．．．．．．等层带来影响。 
  （注：关于加载 DRILL 文件，在 CAM350 V6 中，是不能自动加载的，但在 CAM350 V7 中就可以实现自动加载孔

径，而无须手工再调整，与 V2001 中一样，很方便的，具体操作请看经验技巧） 

 
 
5．如果读入的最后结果如图 A，则表示你读入的 Aperture Format(光栅格式)有错。 
   这时你就要检查你读入时所选的格式。如下所说: 

   
 
 
辨认 aperture 读入正确与否的方法： 
z 看 aperture table 是否均已正确读入，不存在 undefined aperture。(即未有定义的 D 码) 

[A] 未 能 读 入 [B] 正确读入 aperture
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z 如果线路层（copper layer）中有 QFP 的话，看其方向是否对: 

         
 
 
这种情况通常是 rectangle 的 aperture 被读反而造成的（X, Y 读颠倒）。 
z 其它明显的不正常现象，如：线端无 pad、不合理短、短路等 
 
当你读入 RS-274 格式 gerber file 发现外形尺寸正确，而线路、pad 明显偏小或偏大，这通常是 CAM350 的.arl 文件

单位设置与读入的 aperture 单位不符造成的。正确读入做法如下： 
z 使用 AutoImport 功能，点击 Next 与 Scan each Gerber 选项 

CAM350 V6.0 Aperture Table 

看此按钮是否可用，如

果是，则说明还有未定

义的 aperture 

正确读入 QFP 错误读入 QFP 
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z 在出现的对话框中，察看 CAM350 读入时所用的.arl 模板名是什么 

 
z 找到此.arl 文件，修改其单位，另存为改名的.arl 文件 

 
.arl 文件的文件名通常与.arl 模板名类似，上例的.arl 文件的文件名为：pcad8.arl（CAM350 自带的标准.arl 文件） 
 
对于.arl 文件的详细说明在 CAM350 帮助中详细谈到，你可进行参考。 

.arl 模板名 

aperture 单位定义 



资料整理---收藏天地 2001 站长：killmai   网址：www.edaworld.net  E-MAIL:killmai@163.net  

 
 
如果线宽、pad 大小正确，而外形明显偏大时，会看起来线路过于稀疏，这是因为 gerber file 的单位选错（公制选

成英制）。 
 
 

手 动 输 入: 

a) 标准的 gerber file 格式可分为 RS-274 与 RS-274X 两种，其不同在于： 
z RS-274 格式的 gerber file 与 aperture 是分开的不同文件 
z RS-274X 格式的 aperture 是整合在 gerber file 中的，因此不需要 aperture 文件 

(即，内含 D 码) 
 
 
 
 

File->Import->Gerber Data 
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单击 下如箭头所指，输入 GERBER 文件，按下 选择输入格式，如下图： 

 
前导零、后导零和不导零： 
例：025690 前导零后变为：25690 (Leading) 

025690 后导零后变为：02569 (Trailing) 
025690 不导零后变为：025690 (None) 
 

Gerber file 的格式： 
通常，英制是2.4格式，

公制是 3.3 格式 

单位 

绝对坐标还

是相对坐标 

前导零还是

后导零 

Import Gerber Data 对话框 
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数据格式：整数位+小数位，常用：2.3（英制，整数 2 位，小数 3 位） 
                               2.4（英制，整数 2 位，小数 4 位） 

3.3（英制，整数 3 位，小数 3 位） 
 
 
 
 
 

 

 

 

 

 

 

 

请看下面这段 Gerber 命令： 

X00560Y00320D02* 

X00670Y00305D01* 

X00700Y00305D01* 

 
假定这段命令是使用英寸作单位的。第一句的意思很容易理解——桌面移动到点（00560，00320）处，而不画线。可

是新的问题又产生了，（00560，00320）到底表示的哪一点？是（5.6Inch,3.2Inch），还是（0.56Inch,0.32Inch）,亦或

是（0.056Inch,0.032Inch）？谁也不能说清楚。但是如果设计者告诉您，在小数点前有几位、小数点后面有几位，那

您就能快速的确定这些数据到底代表的是多少。比如，设计师告诉您这段 Gerber 文件是英制 2-3，那么您就能清楚地

知道 00560 表示 0.56Inch(00.560),00320 是 0.32Inch(00.320)。 
 
但事实上，我们往往都要自已猜测出来的，就如上所说一样。 
 
“绝对坐标” 和 “相对坐标” 
绝对坐标：即其坐标以 0 坐标为点，是一个绝对的值。是一个正值。 
相对坐标：看其正负，相对坐标总是有正负的 ，当前坐标总是依照前一坐标递增或递减，就像我们需的数学一样 
 
 
 
为了读对 RS-274 格式的 gerber file，你需要有如下概念： 
z RS-274 格式的 gerber file 必须同其对应的 aperture 文件配合才能正确输入 
z CAM350 的 AutoImport 功能读 RS-274 格式的 gerber file 是能自动辨认 aperture 的格式的（不同的 CAD 软体

产生的 aperture 的格式也是不同的），而 CAM350 的这一功能又是靠其安装目录中.arl 为模板来实现的。 

深入一点如何判断其格式： 
方法一 
如：X535489Y416899D03* 
是六位数的，不是 2.4 就是 3.3，总之加起来是 6 即可 
或在 M:N 组合中用”穷举法”进行调用(即 2:3、2:4、…逐个试) 
 
方法二：根据板面大小 
硬质板中很少有板面尺寸大于 20Inch 的，而大于 20Inch X 20Inch 的是没有的。据此，如果您读出来的图形

大于 20Inch，那就是小数点前的位数太多了。相反，如果您读出俩的图形都堆到原点附近，那十有八九是小

数点后的位数太多了（也就是说，小数点前的位数太少了）。 
这里需要注意的是，小数点前的位数加上小数点后的位数一定要等于 Gerber 文件中最长的数的位数，上例中

就是 5（2+3=5）。 
方法三：根据已知尺寸 
如果您知道一些关于板子的尺寸，那就好办多了。您只要不停的试，大了就把小数点前的位数变小（小数点

后的位数同时变大）；小了就把小数点后的位数变小（小数点前的位数同时变大），如果单位没有搞错，一两

次就能正确了。如果您没有任何尺寸，那您只能找板子上的器件。有一些器件，如 DIP（双列直插集成电路）、

PGA 封装和一些插座，它们引脚的中心距离是 0.1Inch(2.54mm),根据这一点您也能大概地确定数据格式。 
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当我们用 CAM350 不能正确读入 RS-274 格式的 gerber file 时，通常是因为不能正确辨认 aperture 而造成的，这就

需要编写自己的.arl 文件来协助 CAM350 正确读入 gerber file。 
注：能否正确读入 GERBER 文件，关键为对 Aperture Format 的设置。 

孔 径 (Aperture) 
Tables-> Aperture 

 
Next Undefined：跳转到下一个尚未定义的 D 码。 
Remove Unused：删节无用的 D 码 
Go To Dcode：跳转到输入的 D 码 
Next Used：跳转到下一个已用的 D 码 
Compress：将已定义的 D 码排在一起 

.ARL 文件范例 

Aperture 形状定

Aperture 格式定义 
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Go To Custom：跳转到输入的 D 码 
CAM350 支持的 D 码形状有：Aperture Definition 

 
 
新建一个 D 码： 

在左边的 Shape 中选择一个 D 码的形状，然后在右边中输入其数值即可建立起一个新的 D 码了供使用了。 
如：建立一个 Round，然后在 Diameter 中输入这个圆的直径就可以了。 

 
删除或改变 D 码： 

删除 D 码：Edit->Delete 移动光标选择要删除的元素即可完成。 
改变 D 码：进入 Aperture Definition，选择新的 D 码形状替代当前正使用的 D 码形状就行了。 

 
Custom：（自定义 D 码） 

建立自定义 D 码,Tools->Cap Editor 最后保存即可。 
我们可以在 Tools->Cap Editor 中直接创建自定义光圈，这些自定义 D 码形状包括：散热盘、三角形、钻石形、斜角长

方形、异形、子弹形、多多边或任何你所需要到所想要的图形。在 D 码表中，通过改变 D 码类型来替代你所想改变或

替代的 D 码形状，这是非常方面实用的。 
功 能 热 键 (Hot Keys) 

   

Key 热键 Function 功能. Associated Macro Command 相关宏命令  

A Aperture table 光圈表  

C Zoom close 放大鼠标邻近范围 view_close@ 

D Set active Dcode 选择要使用的 D 码 setdcode@ ##=Dcode number 

F Toggle fill mode 显示填充模式

(filled/outline/centerline)实填充、外形

线、中心线 

setvmfill@ #0=centerline, 1=filled, 

2=outlineview_redraw@ 

Round：    圆形 
Square：    正方形 
Rectangle： 矩形 
Target：     靶标 
Thermal：   花孔 
Custom：    自定义 D 码 
Donut：     环形 
Octagon：   八边形 
Oblong：    长椭园形 
而在 CAM350 V7 中还支持 Triangle(三角形)、 
Hexagon(六角形)、Ellipse(椭园形)、Diamond(菱形)
等等 16 种 D 码图形。 
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G Turn graphics on/off(speeds up edit 

selections) 图形，快速选择编辑 

view_SuppressGrphcs@ # 0=on, 1=off 

H Highlight active Dcode 将当前 D 码高

亮显示 

Hilite_dcode_on@ Hilite_dcode_off@ 

K Turn layer(s) off (inactive) 将指定层删

除（非当前层）    

layer_kill@ Must be followed by edit_layer@ 0,-2,-2,0,1 

layer number, draw color, flash color, layer type, 1=off 

 Turn layer(s) on (active)指定当前层 layer_set@ Must be followed by edit_layer@0,-2,-2,0,0 

layer number, draw color, flash color, layer type, 0=on 

M Toggle command line (memory 

used/command prompt/macro 

command 职在指定在线命令模式 （使

用记忆/命令提示/宏命令） 

   

  

N Toggle active layer negative/positive 

(display only)当前层反相显示 

view_NegateActiveLayer@ # 0=Negative, 1=Positive 

O Toggle orthogonal snap (0/45/90 

degrees)改变走线模式 

setortho@ # 0=90, 1=45, 2=0 

P Zoom previous 显示图形上一次大小 view_previous@ 

Q Query all data 讯问所有图元属性 query_all@ 

R Redraw 重画屏幕 view_redraw@ 

S Snap-to-grid on/off 光标按网格移动开

关 

setgridsnap@ # 0=off, 1=on 

T Transparency on/off 透视显示开关 setvmtrans@ # 0=off, 1=on 

U Undo 恢复 undo@ 

Ctrl U Redo 重做上次操作 redo@ 

V Grid visibility on/off 网格显示开关 setgridvis@ # 1=on, 0=off 
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W Zoom window (must select 2 points)  

框选显示，必须选择两点 

view_window@ For example: view_window@ axy@ 

1375.0,5350.0 axy@ 3300.0,3175.0 back@ 

X Toggle cursor 光标模式 

(target/cross-hair)长短十字、交叉 

 

Y Layer table 层表设置  

Z Object snap on/off 目标选取框开关（以

光标为中心） 

setsnap@ # 1=on, 0=off 

F1 Context-Sensitive Help  

F2-F9, 

F11, F12 

User-Definable keys  

Home View all 显示全部图形 view_all@ 

0-9 Number keys 1 to 9 turn ON Layer 

Sets 1 to 9, respectively. 0 turns on 

layerset 10. The first layer of the 

layerset is made active. (If no layer 

set exists, nothing happens.)选择当前

层，指定层必须是有的。 

layerset_view@ # # is the number of the layerset to turn 

ON. 

Ins Pan to cursor location         按光标在

面板中位置显示图形 

 

+ Zoom in 放大图形 view_zoomin@ 

- Zoom out 缩小图形 view_zoomout@ 

PgUp Increase snap box size  

加大目标选取框（以光标为中心） 

setsnapdist@ # # in pixels setsnapdistdb@ # # in 

current user units (mils or mm) 

PgDn Decrease snap box size  

减小目标洗取框（以光标为中心） 

setsnapdist@ # # in pixels setsnapdistdb@ # # in 

current user units (mils or mm) 
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注：相关宏命令为命令提示框显示，热键按一次为 0，按二次为 1，三次为 2 
Hotkeys that change during Edit commands 在编辑命令状态下使用的热键 

 

A Select All 选择全部图元   

B Toggle group display box mode/ghost 

mode 指定成组显示模式或精灵模式 

  

C Toggle window mode 

crossing/non-crossing 框选模式，交叉/

不交叉选取 

  

I Toggle windowed selection 

inside/outside 针对框内选取还是框外选

取 

edit_inside@ edit_outside@ 

M Mirror a part during Add|Part and Quick 

Part, or Mirror the Reference 

Designator or Device Name during 

Build Part or in the Part Editor.器件镜

相。只能在放置、编辑、制造器件使用 

quickpart_mirror@ 

T Rotate a part during Add|Part and Quick 

Part, or rotate the Reference 

Designator or Device Name during 

Build Part or in the Part Editor 旋转器

件，只能在放置、编辑、制造器件时使用

quickpart_turn@ partname_Turn@ setturn100angle@ # 

Sets the turn angle. # is 100 times the angle (650=6.5 

degrees) 

W Enable group Window mode使用框选成

组模式显示 

  

Keyboard/Mouse Equivalents 

Spacebar Left mouse button 相当于鼠标左键 

, Center mouse button (re-execute last command)相当于鼠标中键 

Esc Right mouse button 相当于鼠标右键 
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编 辑 (Editing) 功 能 

                

Layer（层）： 
每一个 PCB 板基本上都是由线路层、阻焊层、字符层、钻孔数据层、DRILL 层所组成的，在 CAM350 中，每载入一

层都会以不同的颜色分别开，CAM350 提供了强大的层处理功能。有：层对齐、增加新层、层排序、层删除、层缩放

等 
 
Change（更改）： 
在这里，你可重新设定每个元素的 D 码，字体的大小、样式，坐标的原点等。 
 
Trim Using（使用调整）： 
这个操作只对当前有效的线元素有作用，常用于调整一些线段，如修剪等。[如图：] 

             
 

Line Change （线更改）：不多说了，如图，一看说明了 
 

                 

查看(Viewing)选项 
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正在整理中… 

 

本站后备网址：http://pcb2002new.a2.cn4e.com 

     

     

 


